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SUMMARY 16 
This protocol describes the analysis of fluorescently labeled intracellular compartments in 17 
budding yeast using multi-color 4D (time-lapse 3D) confocal microscopy. The imaging parameters 18 
are chosen to capture adequate signals while limiting photodamage. Custom ImageJ plugins 19 
allow labeled structures to be tracked and quantitatively analyzed. 20 
 21 
ABSTRACT 22 
The goal of this protocol is to characterize how membrane compartments form and transform in 23 
live cells of budding yeast. Many intracellular compartments in yeast are dynamic, and a full 24 
understanding of their properties requires time-lapse imaging. Multi-color 4D confocal 25 
fluorescence microscopy is a powerful method for tracking the behavior and composition of an 26 
intracellular compartment on a time scale of 5-15 minutes. Rigorous analysis of compartment 27 
dynamics requires the capture of thousands of optical sections. To achieve this aim, 28 
photobleaching and phototoxicity are minimized by scanning rapidly at very low laser power, and 29 
the pixel dimensions and Z-step intervals are set to the largest values that are compatible with 30 
sampling the image at full resolution. The resulting 4D data sets are noisy but can be smoothed 31 
by deconvolution. Even with high quality data, the analysis phase is challenging because 32 
intracellular structures are often numerous, heterogeneous, and mobile. To meet this need, 33 
custom ImageJ plugins were written to array 4D data on a computer screen, identify structures 34 
of interest, edit the data to isolate individual structures, quantify the fluorescence time courses, 35 
and make movies of the projected Z-stacks. 4D movies are particularly useful for distinguishing 36 
stable compartments from transient compartments that turn over by maturation. Such movies 37 
can also be used to characterize events such as compartment fusion, and to test the effects of 38 
specific mutations or other perturbations.  39 
 40 
INTRODUCTION 41 
Compartments of the endomembrane system are in constant flux, and their full characterization 42 
requires live cell imaging. Described here is a protocol that employs 4D (time-lapse 3D) confocal 43 
microscopy to visualize fluorescently labeled compartments in budding yeasts. The method was 44 
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developed to track the dynamics of secretory compartments in Pichia pastoris and 45 
Saccharomyces cerevisiae1-3. This protocol focuses on S. cerevisiae, which has a nonstacked Golgi 46 
in which the individual cisternae are optically resolvable4. The unusual Golgi organization in S. 47 
cerevisiae enabled the demonstration by 4D microscopy that a Golgi cisterna initially labels with 48 
resident early Golgi proteins, and then loses those proteins while acquiring resident late Golgi 49 
proteins3,5. This transition can be visualized by creating a strain in which the early Golgi protein 50 
Vrg4 is labeled with GFP while the late Golgi protein Sec7 is labeled with a monomeric red 51 
fluorescent protein. When individual cisternae are tracked, maturation is observed as a green-52 
to-red conversion3. This type of analysis can provide valuable information about protein 53 
localization and compartment identity. For example, two proteins with slightly offset arrival and 54 
departure times might sometimes appear to label different compartments in static images, but 55 
can be seen in 4D movies to label the same compartment at different time points6,7. Thus, 4D 56 
microscopy reveals phenomena that would not otherwise be evident. 57 
 58 
Informative 4D microscopy of yeast compartments can be achieved with appropriate procedures 59 
and equipment2. Whenever possible, fluorescent protein tagging is performed by gene 60 
replacement8 to avoid overexpression artifacts. Because intracellular structures are often very 61 
dynamic, 4D imaging is needed to ensure that a structure is tracked reliably over time. The 62 
protocol described here employs a laser scanning confocal microscope equipped with high 63 
sensitivity detectors. With this device, the entire cell volume of S. cerevisiae can be imaged by 64 
confocal microscopy approximately every 1-3 s, with 2 s intervals being typical. Data can be 65 
collected for up to 5-15 min depending on the labeling densities of the fluorophores and their 66 
photophysical properties. The main hurdle is to minimize photobleaching. For this purpose, the 67 
laser intensities are kept as low as possible, the confocal scan speed is maximized, and the optical 68 
parameters are configured to image at the Nyquist limit in order to capture the relevant 69 
information while avoiding excessive light exposure. These settings are also expected to alleviate 70 
phototoxicity, a factor that is often overlooked during live cell imaging9-11. The resulting noisy 71 
data are processed with bleach correction and deconvolution algorithms to facilitate 72 
quantification of fluorescence intensities. 73 
 74 
Even with high quality 4D movies, the analysis is tricky because yeast compartments tend to be 75 
numerous, heterogeneous, and mobile. Due to the intrinsic limitations of confocal microscopy 76 
and the non-optimal settings required for prolonged 4D imaging, fluorescent structures that are 77 
near each other are hard to resolve. This problem can be circumvented by focusing on the small 78 
number of fluorescent structures that remain optically resolvable for the duration of the labeling 79 
period, with the assumption that those structures are representative of the whole population of 80 
labeled compartments. Fluorescent compartments that can be reliably tracked are identified by 81 
viewing movies of projected Z-stacks and by creating a series of montages in which the optical 82 
sections for each time point are arrayed on a computer screen. This analysis employs custom 83 
ImageJ12 plugins, which allow an individual structure to be tracked in isolation.  84 
 85 
Recent methods papers covered the use of fluorescent proteins in yeast13 as well as the theory 86 
and practice of 4D confocal imaging of yeast cells2. This protocol focuses on the key practical 87 
aspects of a 4D imaging experiment. It includes some enhancements to previously described 88 



  

procedures, as well as updated versions of the ImageJ plugin code and documentation. The 89 
example shown focuses on Golgi dynamics, but this protocol is equally suitable for imaging other 90 
yeast compartments. 91 
 92 
PROTOCOL 93 
 94 
1. Preparation 95 
 96 
1.1. Make nonfluorescent minimal NSD medium2. The absence of riboflavin is expected to reduce 97 
background intracellular green fluorescence and associated phototoxicity. To further suppress 98 
photodamage, add Trolox14 to 0.5 mM during imaging. 99 
 100 
1.2. Grow the yeast strain overnight at ~23 °C to logarithmic phase in 5 mL NSD in a 50-mL baffled 101 
flask with good aeration. About 3-4 h prior to analysis, dilute the yeast culture in fresh NSD plus 102 
Trolox so that the final OD600 will be 0.5-0.8 at the time of imaging. 103 
 104 
1.3. Prepare a 2 mg/mL solution of concanavalin A (ConA). If desired, freeze aliquots of this 105 
solution in liquid nitrogen and store at -80 °C.  106 
 107 
1.4. Spin the ConA solution for 5 min at full speed in a microcentrifuge to remove particulate 108 
matter that may interfere with imaging. Then add 250 μL of the supernatant to a clean 35-mm 109 
coverglass bottom microscopy dish. After 15 min, wash 2-3 times with 2 mL of dH2O and let dry.  110 
 111 
1.5. Add 250 μL of the yeast culture to the ConA-coated dish, wait 10 min to allow the cells to 112 
adhere, and gently wash 2-3 times with 2 mL NSD. Cover the cells with 2 mL fresh NSD plus Trolox.  113 
 114 
2. Imaging  115 
 116 
2.1. Use a 63X or 100X oil immersion lens. A numerical aperture (NA) of 1.40 is sufficient, but a 117 
higher NA lens can also be used. 118 
 119 
2.2. Format the frame size to 256 x 128 (width x height). If a larger frame size is needed, 120 
increasing the width will not reduce the scan speed as long as the confocal microscope is 121 
equipped with a resonant scanner.  122 
 123 
2.3. Adjust the zoom factor to make the pixel size ~80 nm.  124 
 125 
2.4. Use the maximum scan speed, which is typically on the order of 8 kHz. Turn on bidirectional 126 
X scanning if it is available, and if control experiments confirm that the scans from the two 127 
directions are in register. 128 
 129 
2.5. Set the line accumulation to 4 or 6. Be sure to use accumulation (summing) instead of 130 
averaging. 131 
 132 



  

2.6. Set the pinhole to 1.2 Airy units. Empirically, when imaging live yeast cells, this setting 133 
captures more photons than the standard choice of 1.0 Airy unit while causing no appreciable 134 
loss of resolution. 135 
 136 
2.7. For each fluorescence channel, set the excitation wavelength, assign a high sensitivity 137 
detector, set the emission wavelength range, and turn on photon counting mode if available. The 138 
wavelength choices will depend on the fluorophores. As an example, excite GFP fluorescence at 139 
488 nm and collect from 495-550 nm, and excite mCherry fluorescence at 561 nm and collect 140 
from 575-750 nm.  141 
 142 
2.8. Set the intensity of each laser to be as low as possible. This setting must be determined 143 
empirically. An appropriate intensity will result in capture of a noisy but interpretable image 144 
sequence, with the fluorescence signal bleaching no more than 50% by the end of a 5-min movie. 145 
On the confocal microscope used here (see Table of Materials), this intensity corresponds to a 146 
laser power setting on the order of 5%. 147 
 148 
2.9. Use notch filters or time gating to avoid capturing reflected light from the coverslip. If time 149 
gating is available, set the gating window to 0.6 – 10.0 ns. 150 
 151 
2.10. Turn on brightfield imaging and use a low sensitivity detector for data collection. Set the 152 
gain to a level that makes the cells clearly visible. Do not use differential interference contrast 153 
(DIC) because the prism will interfere with the capture of reliable fluorescence data.  154 
 155 
2.11. Set the Z-step interval to 0.25-0.35 μm. Image the entire volume of the yeast cells by 156 
collecting about 20-25 optical sections per Z-stack. Specify the directionality of imaging such that 157 
“down” moves toward the coverslip.  158 
 159 
2.12. For a typical movie, set the time interval between Z-stacks to 2 s and set the movie duration 160 
to 5 to 10 min. Depending on the compartment under study, reduce the interval to make shorter 161 
movies of relatively fast dynamics, or increase the interval to make longer movies of relatively 162 
slow dynamics. 163 
 164 
2.13. Save the movie as an 8-bit TIFF file with the brightfield images in the last channel. Higher 165 
bit depths are unnecessary at this stage, and the processing pipeline is configured to accept 8-bit 166 
TIFF data. 167 
 168 
3. Deconvolution  169 
 170 
3.1.  Launch the deconvolution software (see Table of Materials), using the Classic Maximum 171 
Likelihood Estimation algorithm15.  172 
 173 
3.2. Open the data set generated in step 2.13. Select “Deconvolution wizard”. Inspect the values 174 
displayed in the “Parameter wizard”. The imaging parameters should be detected and correctly 175 



  

displayed. Under “Refractive indexes”, change the “Embedding med.” value to 1.40 to 176 
approximate the yeast cytoplasm. Select “Set all verified” and “Accept”. 177 
 178 
3.3. Proceed through the “Deconvolution wizard” for each fluorescence channel. Select 179 
“Manual” as the mode for background estimation. Inspect the raw data fluorescence intensity 180 
profile to determine an estimated background value, which is typically about 5.0. 181 
 182 
3.4. In the deconvolution setup menu, enter a “Maximum iterations” value of 40 and turn off 183 
bleach correction. Enter an estimated SNR value, which is typically about 0.1. Click “Deconvolve”. 184 

 185 
3.5. If necessary, return to the original data file, adjust the background and SNR values, and 186 
repeat the deconvolution, until noise is sufficiently removed without eliminating genuine 187 
fluorescence from dim structures.  188 
 189 
3.6. Merge the brightfield and deconvolved fluorescence channels. For subsequent movie editing 190 
steps in ImageJ, arrange the channels such that red is first, green (if present) is next, blue (if 191 
present) is next, and brightfield is last. Save the image sequence as an 8-bit TIFF file.  192 
 193 
4. Bleach Correction and Movie Generation 194 
 195 
4.1. Import the deconvolved image sequence into ImageJ and convert it into a hyperstack by 196 
choosing Image > Hyperstacks > Stack to Hyperstack. Select “xyzct” from the drop-down menu, 197 
and fill in the number of channels, Z-stack slices, and time frames.  198 
 199 
4.2. Choose Image > Color > Split Channels. 200 
 201 
4.3. Correct the fluorescence channels for photobleaching using the ImageJ plugin available from 202 
http://wiki.cmci.info/downloads/bleach_corrector. Once that plugin has been downloaded and 203 
installed, choose Plugins > EMBLtools > Bleach Correction. Select “Exponential Fit.” 204 
 205 
4.4. To merge the brightfield and bleach-corrected fluorescence channels into a hyperstack, 206 
choose Image > Color > Merge Channels. Save the resulting hyperstack as an 8-bit TIFF file. 207 
 208 
4.5. Install the custom ImageJ plugins provided with this protocol. Follow the instructions in the 209 
accompanying document to view, edit, and quantify the image sequence, and to produce a final 210 
movie of the projected Z-stacks. 211 
 212 
REPRESENTATIVE RESULTS 213 
The example given here documents and quantifies the maturation of two yeast Golgi cisternae 214 
as visualized by dual-color 4D confocal microscopy3. A yeast cell contains on the order of 10-15 215 
Golgi cisternae, each of which matures over a time course of approximately 2-4 min. Maturation 216 
can be visualized by tagging the early Golgi marker Vrg4 with GFP and by tagging the late Golgi 217 
marker Sec7 with a red fluorescent protein such as mCherry or mScarlet. An individual cisterna 218 
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labels initially with the Vrg4 marker, then undergoes a brief transition in which the markers are 219 
exchanged, and then labels with the Sec7 marker. 220 
 221 
Because the cell contains multiple Golgi cisternae that are quite mobile, it is challenging to follow 222 
an individual cisterna throughout the entire labeling period. Cisternae are often too close 223 
together to be resolved unambiguously given the temporal and spatial limitations of the image 224 
data. Moreover, Golgi cisternae occasionally fuse16, and late Golgi cisternae tend to cluster at 225 
sites of polarized growth17. As a result, a 4D movie rarely yields more than one or two cisternae 226 
that can be tracked reliably. One of the most challenging steps in the method is to examine the 227 
initial movie of the Z-stack projections and identify cisternae that are promising candidates for 228 
analysis. 229 
 230 
The figures depict sequential steps in the procedure:  231 
 232 
Figure 1 shows frames from movies of the Z-stack projections of either raw data or deconvolved 233 
and bleach-corrected data. Figure 1A compares the first frames for the raw versus deconvolved 234 
data. Figure 1B is from the same deconvolved movie, and shows several frames in which the two 235 
cisternae that were analyzed label first with the green Vrg4 marker and later with the red Sec7 236 
marker. Those cisternae were chosen because they are clearly separated from other labeled 237 
structures for most of the movie. The images in this figure were generated from either raw or 238 
deconvolved and bleach-corrected 4D TIFF hyperstacks using the “Make Montage Series”, 239 
“Montage Series to Hyperstack”, and “Project Hyperstack” plugins. 240 
 241 
Figure 2 shows part of the montage that was created for a Z-stack at one of the time points, both 242 
before and after editing to isolate the signal from one of the chosen cisternae. The images in this 243 
figure were generated from the deconvolved and bleach-corrected 4D TIFF hyperstack using the 244 
“Make Montage Series” and “Edit Montage Series” plugins. 245 
 246 
Figure 3 shows several frames from the final movie of the projected Z-stacks (Video 1), with the 247 
original projections at the top and the edited projections at the bottom. The images in this figure 248 
were generated from the original and edited montages using the “Montage Series to 249 
Hyperstack”, “Merge Hyperstacks”, and “Project Hyperstacks” plugins. 250 
 251 
Figure 4 shows quantification of the green and red fluorescence signals from the chosen 252 
cisternae. The data for this figure were generated from the edited hyperstacks using the “Analyze 253 
Edited Movie” plugin.  254 
 255 
Analysis of these Golgi cisternae revealed that the Vrg4 marker arrives and persists for about 80 256 
s, and then the Sec7 marker arrives and persists for about 60 s, with a brief period of overlap 257 
between the two markers. As illustrated by this example, 4D imaging provides both qualitative 258 
and quantitative information about the dynamics of a yeast compartment. 259 
 260 
  261 



  

FIGURE LEGENDS 262 
 263 
Figure 1. Projections of Z-stacks from a 4D movie. (A) Projections of the raw data (left) and 264 
deconvolved data (right) from the first Z-stack in a 4D movie. The green signal is from GFP-Vrg4, 265 
the red signal is from Sec7-mScarlet, and the gray signal is the brightfield images of the yeast 266 
cells. Scale bar, 2 μm. (B) Representative frames from the initial movie shown in (A) of the 267 
deconvolved and projected Z-stacks. Time points are indicated. The arrows mark the two 268 
cisternae that were chosen for analysis. 269 
 270 
Figure 2. A portion of the montage from the Z-stack corresponding to the 01:20 time point. 271 
Each image in the montage is an optical section. The top panel show part of the original montage, 272 
and the bottom panel show the corresponding part of the edited montage in which the 273 
fluorescence signals from the chosen cisterna were selectively retained. In each panel, the optical 274 
sections are ordered from left to right in the first row and then from left to right in the second 275 
row. Scale bar, 2 μm. 276 
 277 
Figure 3. Frames from the final movie of the projected Z-stacks. In these excerpts from Video 1, 278 
the original images are shown above the edited images. The first five frames show one cisterna 279 
that undergoes a green-to-red transition, and the next five frames show a second cisterna that 280 
undergoes a similar transition. Arrows overlaid on the original images indicate the cisternae that 281 
were tracked. Scale bar, 2 μm. 282 
 283 
Figure 4. Quantification of the fluorescence signals from Video 1. The graphs represent the GFP-284 
Vrg4 and Sec7-mScarlet signals from the two cisternae chosen for analysis, where the top panel 285 
represents the cisterna that becomes visible at the beginning of the movie and the bottom panel 286 
represents the cisterna that becomes visible later in the movie. Time zero is defined for each 287 
cisterna as the frame just before GFP-Vrg4 fluorescence was first detected. 288 
 289 
Video 1. Final movie of the projected Z-stacks. The upper panel shows the original projections, 290 
and the lower panel shows the edited projections in which only the two cisternae chosen for 291 
analysis are visible. 292 
 293 
DISCUSSION 294 
4D confocal imaging of yeast organelles requires careful tuning of multiple parameters. The major 295 
concern is photobleaching and phototoxicity. A typical 4D movie involves collecting thousands of 296 
optical sections, so the laser illumination must be kept as low as possible. Tandem fluorescent 297 
protein tags can be used to boost the signal without increasing expression of the tagged 298 
protein18,19. Maximizing the scan speed helps to limit photodamage, and also allows Z-stacks to 299 
be captured at suitably short intervals. Voxel sizes that are at the Nyquist limit in both XY and Z 300 
minimize light exposure while theoretically recovering the information that is available from the 301 
optical setup20. In the end, each voxel in a signal-containing area of an optical section will typically 302 
receive only 1-3 photons. This amount of information is far below what is normally recommended 303 
for optimal imaging with a single Z-stack, or for deconvolution. But deconvolution still helps by 304 
smoothing the noisy signals15, and such data sets can be analyzed and quantified. 305 



  

 306 
Even with a high quality 4D dataset, tracking of labeled organelles is a complex task. With the 307 
ImageJ plugins provided here, a researcher can array each Z-stack on the computer screen and 308 
can easily move back and forth between time points and between the original and edited data. 309 
Those tools allow the labeled structures to be tracked through time and space with reasonable 310 
confidence. However, subjective judgment plays a necessary part, and bias must be avoided 311 
whenever possible. Particle tracking software could potentially help but is not yet sophisticated 312 
enough for most of the phenomena that are being studied. To offset this limitation, it is best to 313 
examine multiple markers and to test predictions of the models in different ways3,6,7. 314 
 315 
4D confocal imaging has played a pivotal role in characterizing the yeast secretory and endocytic 316 
pathways. This method demonstrated that ER exit sites form de novo and persist indefinitely1, 317 
confirmed that Golgi cisternae mature3,5, and clarified the role of the COPI vesicle coat in Golgi 318 
maturation7,21. More recently, 4D imaging provided evidence that the yeast early endosome is 319 
identical to the late Golgi, and that the yeast late endosome is a long-lived compartment6. While 320 
static imaging of fluorescently tagged compartments continues to be valuable, 4D imaging offers 321 
unique insights into the operating principles of yeast organelles. 322 
 323 
An exciting recent development in the availability of self-labeling proteins for fluorescent 324 
tagging22. SNAP-tag behaves poorly as a fusion partner in yeast, but HaloTag behaves well. Bright 325 
and photostable membrane-permeant HaloTag substrates23 have made it possible to perform 4D 326 
confocal imaging with far-red dyes6. Addition of a far-red imaging channel to the previously used 327 
green and red imaging channels allows robust three-color 4D microscopy (our unpublished data), 328 
thereby expanding the range of phenomena that can be studied in yeast by live cell imaging. 329 
 330 
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ARTICLE AND VIDEO LICENSE AGREEMENT 

Title of Article: 

Author(s):  

Item 1 (check one box): The Author elects to have the Materials be made available (as described at 

http://www.jove.com/author) via:      Standard Access       Open Access 

Item 2 (check one box): 

 The Author is NOT a United States government employee. 

 The Author is a United States government employee and the Materials were prepared in the 
course of his or her duties as a United States government employee. 

 The Author is a United States government employee but the Materials were NOT prepared in the 
course of his or her duties as a United States government employee. 

ARTICLE AND VIDEO LICENSE AGREEMENT 

1. Defined Terms.  As used in this Article and Video License
Agreement, the following terms shall have the following
meanings: “Agreement” means this Article and Video License
Agreement; “Article” means the article specified on the last
page of this Agreement, including any associated materials
such as texts, figures, tables, artwork, abstracts, or summaries 
contained therein; “Author” means the author who is a
signatory to this Agreement; “Collective Work” means a work,
such as a periodical issue, anthology or encyclopedia, in which
the Materials in their entirety in unmodified form, along with a
number of other contributions, constituting separate and
independent works in themselves, are assembled into a
collective whole; “CRC License” means the Creative Commons
Attribution-Non Commercial-No Derivs 3.0 Unported
Agreement, the terms and conditions of which can be found
at: http://creativecommons.org/licenses/by-nc-
nd/3.0/legalcode; “Derivative Work” means a work based
upon the Materials or upon the Materials and other pre-
existing works, such as a translation, musical arrangement,
dramatization, fictionalization, motion picture version, sound
recording, art reproduction, abridgment, condensation, or any
other form in which the Materials may be recast, transformed,
or adapted; “Institution” means the institution, listed on the
last page of this Agreement, by which the Author was
employed at the time of the creation of the Materials; “JoVE”
means MyJove Corporation, a Massachusetts corporation and
the publisher of The Journal of Visualized Experiments;
“Materials” means the Article and / or the Video; “Parties” 
means the Author and JoVE; “Video” means any video(s) made
by the Author, alone or in conjunction with any other parties,
or by JoVE or its affiliates or agents, individually or in
collaboration with the Author or any other parties,
incorporating all or any portion of the Article, and in which the
Author may or may not appear.

2. Background.  The Author, who is the author of the Article,
in order to ensure the dissemination and protection of the
Article, desires to have the JoVE publish the Article and create
and transmit videos based on the Article.  In furtherance of
such goals, the Parties desire to memorialize in this Agreement
the respective rights of each Party in and to the Article and the
Video.

3. Grant of Rights in Article.  In consideration of JoVE agreeing
to publish the Article, the Author hereby grants to JoVE,
subject to Sections 4 and 7 below, the exclusive, royalty-free,
perpetual (for the full term of copyright in the Article,
including any extensions thereto) license (a) to publish,
reproduce, distribute, display and store the Article in all forms,
formats and media whether now known or hereafter
developed (including without limitation in print, digital and
electronic form) throughout the world, (b) to translate the
Article into other languages, create adaptations, summaries or
extracts of the Article or other Derivative Works (including,
without limitation, the Video) or Collective Works based on all
or any portion of the Article and exercise all of the rights set
forth in (a) above in such translations, adaptations,
summaries, extracts, Derivative Works or Collective Works and
(c) to license others to do any or all of the above.  The
foregoing rights may be exercised in all media and formats,
whether now known or hereafter devised, and include the
right to make such modifications as are technically necessary
to exercise the rights in other media and formats.  If the “Open
Access” box has been checked in Item 1 above, JoVE and the
Author hereby grant to the public all such rights in the Article
as provided in, but subject to all limitations and requirements
set forth in, the CRC License.

1 
612542.6

4D Microscopy of Yeast

Natalie Johnson and Benjamin S Glick

X

X

Author License Agreement (ALA) Click here to access/download;Author License Agreement
(ALA);Author_License_Agreement.pdf

http://www.jove.com/author
http://www.editorialmanager.com/jove/download.aspx?id=879172&guid=33c4651a-3cf9-4aa0-b796-3678975a1ea1&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=879172&guid=33c4651a-3cf9-4aa0-b796-3678975a1ea1&scheme=1


ARTICLE AND VIDEO LICENSE AGREEMENT 

4. Retention of Rights in Article.  Notwithstanding the
exclusive license granted to JoVE in Section 3 above, the
Author shall, with respect to the Article, retain the non-
exclusive right to use all or part of the Article for the non-
commercial purpose of giving lectures, presentations or
teaching classes, and to post a copy of the Article on the
Institution’s website or the Author’s personal website, in each
case provided that a link to the Article on the JoVE website is
provided and notice of JoVE’s copyright in the Article is
included.  All non-copyright intellectual property rights in and
to the Article, such as patent rights, shall remain with the
Author.

5. Grant of Rights in Video – Standard Access.  This Section 5
applies if the “Standard Access” box has been checked in Item
1 above or if no box has been checked in Item 1 above.  In
consideration of JoVE agreeing to produce, display or
otherwise assist with the Video, the Author hereby
acknowledges and agrees that, Subject to Section 7 below,
JoVE is and shall be the sole and exclusive owner of all rights of
any nature, including, without limitation, all copyrights, in and
to the Video.  To the extent that, by law, the Author is
deemed, now or at any time in the future, to have any rights
of any nature in or to the Video, the Author hereby disclaims
all such rights and transfers all such rights to JoVE. 

6. Grant of Rights in Video – Open Access.  This Section 6
applies only if the “Open Access” box has been checked in
Item 1 above.  In consideration of JoVE agreeing to produce,
display or otherwise assist with the Video, the Author hereby
grants to JoVE, subject to Section 7 below, the exclusive,
royalty-free, perpetual (for the full term of copyright in the
Article, including any extensions thereto) license (a) to publish,
reproduce, distribute, display and store the Video in all forms,
formats and media whether now known or hereafter
developed (including without limitation in print, digital and
electronic form) throughout the world, (b) to translate the
Video into other languages, create adaptations, summaries or
extracts of the Video or other Derivative Works or Collective
Works based on all or any portion of the Video and exercise all
of the rights set forth in (a) above in such translations,
adaptations, summaries, extracts, Derivative Works or
Collective Works and (c) to license others to do any or all of
the above.  The foregoing rights may be exercised in all media
and formats, whether now known or hereafter devised, and
include the right to make such modifications as are technically
necessary to exercise the rights in other media and formats.
For any Video to which this Section 6 is applicable, JoVE and 
the Author hereby grant to the public all such rights in the
Video as provided in, but subject to all limitations and
requirements set forth in, the CRC License.

7. Government Employees.  If the Author is a United States
government employee and the Article was prepared in the
course of his or her duties as a United States government
employee, as indicated in Item 2 above, and any of the
licenses or grants granted by the Author hereunder exceed the
scope of the 17 U.S.C. 403, then the rights granted hereunder
shall be limited to the maximum rights permitted under such

statute.  In such case, all provisions contained herein that are 
not in conflict with such statute shall remain in full force and 
effect, and all provisions contained herein that do so conflict 
shall be deemed to be amended so as to provide to JoVE the 
maximum rights permissible within such statute. 

8. Likeness, Privacy, Personality.  The Author hereby grants
JoVE the right to use the Author’s name, voice, likeness,
picture, photograph, image, biography and performance in any
way, commercial or otherwise, in connection with the
Materials and the sale, promotion and distribution thereof.
The Author hereby waives any and all rights he or she may
have, relating to his or her appearance in the Video or
otherwise relating to the Materials, under all applicable
privacy, likeness, personality or similar laws.

9. Author Warranties.  The Author represents and warrants
that the Article is original, that it has not been published, that
the copyright interest is owned by the Author (or, if more than
one author is listed at the beginning of this Agreement, by
such authors collectively) and has not been assigned, licensed,
or otherwise transferred to any other party. The Author
represents and warrants that the author(s) listed at the top of
this Agreement are the only authors of the Materials.  If more
than one author is listed at the top of this Agreement and if
any such author has not entered into a separate Article and
Video License Agreement with JoVE relating to the Materials,
the Author represents and warrants that the Author has been
authorized by each of the other such authors to execute this
Agreement on his or her behalf and to bind him or her with
respect to the terms of this Agreement as if each of them had
been a party hereto as an Author. The Author warrants that
the use, reproduction, distribution, public or private
performance or display, and/or modification of all or any
portion of the Materials does not and will not violate, infringe
and/or misappropriate the patent, trademark, intellectual
property or other rights of any third party.  The Author
represents and warrants that it has and will continue to
comply with all government, institutional and other
regulations, including, without limitation all institutional,
laboratory, hospital, ethical, human and animal treatment,
privacy, and all other rules, regulations, laws, procedures or
guidelines, applicable to the Materials, and that all research
involving human and animal subjects has been approved by
the Author's relevant institutional review board.

10. JoVE Discretion.  If the Author requests the assistance of
JoVE in producing the Video in the Author’s facility, the Author
shall ensure that the presence of JoVE employees, agents or
independent contractors is in accordance with the relevant
regulations of the Author's institution.  If more than one
author is listed at the beginning of this Agreement, JoVE may, 
in its sole discretion, elect not take any action with respect to
the Article until such time as it has received complete,
executed Article and Video License Agreements from each
such author.  JoVE reserves the right, in its absolute and sole
discretion and without giving any reason therefore, to accept
or decline any work submitted to JoVE.  JoVE and its
employees, agents and independent contractors shall have
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full, unfettered access to the facilities of the Author or of the 
Author’s institution as necessary to make the Video, whether 
actually published or not.  JoVE has sole discretion as to the 
method of making and publishing the Materials, including, 
without limitation, to all decisions regarding editing, lighting, 
filming, timing of publication, if any, length, quality, content 
and the like. 
 
11.  Indemnification.  The Author agrees to indemnify JoVE 
and/or its successors and assigns from and against any and all 
claims, costs, and expenses, including attorney’s fees, arising 
out of any breach of any warranty or other representations 
contained herein.  The Author further agrees to indemnify and 
hold harmless JoVE from and against any and all claims, costs, 
and expenses, including attorney’s fees, resulting from the 
breach by the Author of any representation or warranty 
contained herein or from allegations or instances of violation 
of intellectual property rights, damage to the Author’s or the 
Author’s institution’s facilities, fraud, libel, defamation, 
research, equipment, experiments, property damage, personal 
injury, violations of institutional, laboratory, hospital, ethical, 
human and animal treatment, privacy or other rules, 
regulations, laws, procedures or guidelines, liabilities and 
other losses or damages related in any way to the submission 
of work to JoVE, making of videos by JoVE, or publication in 
JoVE or elsewhere by JoVE.  The Author shall be responsible 
for, and shall hold JoVE harmless from, damages caused by 
lack of sterilization, lack of cleanliness or by contamination 
due to the making of a video by JoVE its employees, agents or 
independent contractors.  All sterilization, cleanliness or 
decontamination procedures shall be solely the responsibility 
of the Author and shall be undertaken at the Author’s 

expense.  All indemnifications provided herein shall include 
JoVE’s attorney’s fees and costs related to said losses or 
damages.  Such indemnification and holding harmless shall 
include such losses or damages incurred by, or in connection 
with, acts or omissions of JoVE, its employees, agents or 
independent contractors. 
 
12.  Fees.  To cover the cost incurred for publication, JoVE 
must receive payment before production and publication the 
Materials. Payment is due in 21 days of invoice. Should the 
Materials not be published due to an editorial or production 
decision, these funds will be returned to the Author. 
Withdrawal by the Author of any submitted Materials after 
final peer review approval will result in a US$1,200 fee to 
cover pre-production expenses incurred by JoVE.  If payment is 
not received by the completion of filming, production and 
publication of the Materials will be suspended until payment is 
received. 
 
13.  Transfer, Governing Law.  This Agreement may be 
assigned by JoVE and shall inure to the benefits of any of 
JoVE’s successors and assignees.  This Agreement shall be 
governed and construed by the internal laws of the 
Commonwealth of Massachusetts without giving effect to any 
conflict of law provision thereunder.  This Agreement may be 
executed in counterparts, each of which shall be deemed an 
original, but all of which together shall be deemed to me one 
and the same agreement.  A signed copy of this Agreement 
delivered by facsimile, e-mail or other means of electronic 
transmission shall be deemed to have the same legal effect as 
delivery of an original signed copy of this Agreement.   

 
A signed copy of this document must be sent with all new submissions. Only one Agreement required per submission. 

 
CORRESPONDING AUTHOR: 

Name:   

Department:   

Institution:  

Article Title:  

Signature:   Date:  
 
Please submit a signed and dated copy of this license by one of the following three methods: 

1) Upload a scanned copy of the document as a pfd on the JoVE submission site; 
2) Fax the document to +1.866.381.2236; 
3) Mail the document to JoVE / Attn: JoVE Editorial / 1 Alewife Center #200 / Cambridge, MA 02139 

 
For questions, please email submissions@jove.com or call +1.617.945.9051 
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Editorial comments: 
Changes to be made by the Author(s) regarding the written manuscript: 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are no 

spelling or grammar issues. 

2. Figure 4: Please change “sec” to “s”. 

3. Please provide an email address for each author. 

4. Please rephrase the Long Abstract to more clearly state the goal of the protocol. 

5. Please define all abbreviations before use. 

6. Please use SI abbreviations for all units: L, mL, µL, h, min, s, etc. 

7. Please include a space between all numbers and their corresponding units: 15 mL, 37 °C, 60 s; 

etc. 

8. Please revise the protocol text to avoid the use of any personal pronouns (e.g., "we", "you", 

"our" etc.). 

9. Please revise the protocol to contain only action items that direct the reader to do something. 

The actions should be described in the imperative tense in complete sentences wherever possible. 

Avoid usage of phrases such as “could be,” “should be,” and “would be” throughout the 

Protocol. Any text that cannot be written in the imperative tense may be added as a “Note.” 

10. 1.2: Please specify the growth conditions (temperature, etc.). 

11. 1.3: Please revise so that each step contains only 2-3 actions per step and a maximum of 4 

sentences per step. Use sub-steps as necessary. What volume of dH2O is used to wash? 

12. References: Please do not abbreviate journal titles. Please include volume and issue numbers 

for all references. 

 

The requested changes have been made. 

 

 

  

Rebuttal Letter Click here to access/download;Rebuttal Letter;Response to
Reviews 2.docx

http://www.editorialmanager.com/jove/download.aspx?id=886866&guid=7c80f3b1-cd44-49c7-86cd-da766086ba1c&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=886866&guid=7c80f3b1-cd44-49c7-86cd-da766086ba1c&scheme=1


Reviewers' comments: 
 

Reviewer #1: 
Manuscript summary: 

In this manuscript, Johnson and Glick described a method to track the behavior and composition 

of an intracellular compartment in yeast using multi-color, time-lapse imaging. The protocol 

includes detailed imaging parameter settings for confocal microscopy and the procedures for 

subsequent image processing. Additionally, they provide a useful ImageJ plugin and its detailed 

documents to extract the region of interest from the microscopy data. The manuscript is well 

written, and the protocols are clearly presented. 

 

In this reviewer's opinion, the manuscript is suitable for publication from JoVE provided that the 

following issues are successfully addressed. 

 

Major recommendation: 

1. (Introduction and overall) Although the protocol is written to minimize photobleaching (line 

70), the protocol to reduce photobleaching should also reduce phototoxity induced by 

fluorescence microscopy. Thus, it should be beneficial for both authors and readers to introduce 

the protocol also from the perspective to reduce the phototoxity. Appropriate citations in this 

topic may also help navigate readers to more specialized papers, which may include, but not 

limited to: 

- Laissue et al, 2017 Nat Methods 14: 657-661. 

- Icha et al., 2017 Bioessays 39: 1700003. 

- Carlton et al., 2010 PNAS 107: 16016-16022. 

The last one (Carlton et al.,) analyzed phototoxity using yeast. 

 

We agree that phototoxicity is an important issue. The text has been revised in multiple places 
to emphasize this point, and the suggested references have been added. In addition, the 
protocol was enhanced to state that omission of riboflavin is expected to reduce phototoxicity, 
and that inclusion of Trolox may help to reduce photodamage.  

 

Minor recommendations: 

1. (line 50) The "Nakano group" appears abruptly and is puzzling unless the reader looks at the 

reference 5. Can the citations be inserted at the beginning of the sentence, i.e., "We3 and the 

Nakano group5 used…"? 

 

This sentence was revised and clarified. 

 

2. (line 85) Although ImageJ is well-recognized for the scientific community, it is still better to 

cite it. According to their website, there are several ways to cite ImageJ 

(https://imagej.nih.gov/ij/docs/faqs.html). 

 

A citation for ImageJ has been added. 

 

3. (line 115-116) I assume the authors use a confocal microscope equipped with a resonant 



scanner, that is the reason why "increasing the width will not reduce the scan speed". The 

description is also valid for CCD based systems, including spinning disk confocal microscopes. 

However, the readers of this protocol may use confocal microscopes with conventional Galvano 

scanners and PMT (not resonant scanners or CCD), where increasing the width may reduce the 

scan speed. The authors should clarify the microscope types that this description is applied to. 

 

The protocol has been clarified by stating that this recommendation applies to confocal 
microscopes with resonant scanners. 

 

4. (line 200, 228, 261 and others) The phrase of "the final projected movie" is misreading. Its 

usage is understandable in the "Instructions for plugins", but in the main protocol, "the projected 

movie at the final stage of editing" or some equivalent phrases may be appropriate. 

 

The wording throughout the document has been changed to “movie of the projected Z-stacks” 
or similar phrases. 

 

5. (line 200) Please add "to make projections" to the list of the functions ("to view, edit and 

quantify") of the plugins, since the procedure for making projection is not in the main protocol, 

but it is very often mentioned in the "REPRESENTATIVE RESULTS". 

 

This line has been clarified. 

 

6. (line 261) "the complete projections" is not understandable. Does it mean "the projection 

without editing"? 

 

We changed “complete” to “original”, which should be more comprehensible. 

 

7. (Figure 2) Please clarify the order of images in montage. Labeling the indices of the Z sections 

in the figure may help. 

 

The order of the images is now explained in the figure legend. 
 

 

Reviewer #2: 
Manuscript Summary: 

-This is a well written paper. 

-The authors use a challenging system for 4D microscopy (tracking of Golgi cisternae and 

maturation of individual cisternae). 

-The authors reporting an imaging improvement, which is essentially low laser settings 

combined with self-made plug-in modules for Image J for processing/editing of noisy raw data. 

-This system enables an acquisition of z-stacks over prolonged periods of time with very limited 

data loss due to photobleaching. 

-The data shown are of high quality and demonstrate the maturation of individual cisternae (they 

get sequentially labeled with an early and a late Golgi marker). 

 



Major Concerns: 

As the authors are reporting an improvement of their protocol versus regular imaging techniques, 

they should demonstrate how much of an improvement this actually is. This Reviewer suggests 

that the authors take the same raw data set (4D movie), use similar deconvolution settings with 

Huygens software, but later use a conventional imaging software such as Imaris to display the 

movie. Can the authors still show a similar level of resolution? If not, what is the level of 

improvement with their protocol compared to a more conventional imaging protocol? 

 

We are unsure how to respond to this comment. A number of other procedures have been 
used for yeast live cell imaging including Nakano’s SCLIM technology, commercial spinning disk 
confocal microscopy, and lattice light-sheet microscopy. We have not done an objective side-
by-side comparison, and cannot claim that our method is the only one that is suitable or even 
the best one. This article is specifically intended to describe how to perform yeast imaging and 
image analysis by the method that we have optimized. 

 

Minor Concerns: 

The authors also report self-labeling proteins (Snap-tag, Halo-tag) as a recent improvement that 

will facilitate 4D microscopy using three channels. However, they do not show any three channel 

imaging results. The authors should either include a 4D movie acquired with a three channel 

setting to demonstrate the feasibility of this approach, or otherwise remove the entire section on 

three channel 4D movies. 

 

We recently submitted a manuscript that describes three-color 4D confocal imaging, with 
HaloTag linked to a far-red dye supplying the third color. That work is now cited as 
“unpublished data”. We will update the text with a citation if the manuscript is accepted soon 
enough.  

 

 

Reviewer #3: 
Manuscript Summary: 

In this manuscript, authors describe the advantage of multicolor 4 D observation by confocal 

microscopy in analyzing the behaviors of endomembrane compartments in yeast cells. They 

show the important and concrete protocols to achieve effective 4D imaging by using confocal 

microscopy. In addition, publishing practical plug-ins for ImageJ is very useful for many 

researchers doing similar analysis not in yeast cell biology but in all the field of cell biology. The 

paper would be suitable for publication on the JoVE. 

 

Minor Concerns: 

It is better to describe how many watts of laser are actually irradiated from objective lens 

corresponding to this setting of microscopic system. It will give important information for 

researchers who conduct 4D imaging experiments using other confocal microscopies. 

 

Numerical values for laser power are not always useful in our experience. As an alternative, we 
describe in section 2.8 how to adjust the laser intensity to a suitable level. Those guidelines 
should be suitable for any confocal microscopy system.  



 

Reviewer #4: 
This paper nicely outlines a method for taking and analysing timelapse movies of subcellular 

structures in S.Cerevisiae using confocal microscopy and ImageJ. If I were a new user I would 

find the protocols clear and easy to follow, and the figures clearly illustrate the steps of analysis. 

 

General points: 

-Are these recommended as general imaging parameters for S.Cerevisiae or for the Golgi 

specifically? There could be some discussion relating to time intervals and z-section spacing 

when imaging other structures in 4D. 

 

This protocol is generally suited to imaging yeast compartments, and the appropriate time 
interval depends on the dynamics of the compartment being visualized. To emphasize these 
points, we added text at the end of the Introduction and in section 2.12. 

 

-I think the final paragraph of the results section would read more clearly if split into steps - 

mentioning the ImageJ plugin used in each step and the figures referenced as the expected output 

of each step. 

 

We modified the Results as suggested, and agree that the new format is an improvement. 

 

-Some discussion on the best fluorophores would be useful e.g. using newer and brighter 

fluorophores to allow for more intensive imaging. 

 

This topic would require an extensive discussion, which we deem to be outside the scope of the 
article. Instead, we now cite a review that covers the use of fluorescent proteins for yeast 
imaging. 

 

-How might you control for chromatic aberration in analysis like this? Could there be a section 

discussing controls such as labeling the same protein with two different fluorophores. 

 

The reviewer makes a good suggestion. We have done tests with multi-color fluorescent beads, 
but dual tagging of an intracellular yeast protein would be even better. The text has not been 
modified because we have not yet done this control.  

 

Specific Points: 

Protocol: 

2.1) You could talk about the best grade of oil to use at RT (or 25˚C if you're using an 

environment chamber) 

 

For room temperature imaging of the type described here, the standard immersion oil provided 
by the manufacturer is suitable. At one point we tested the Immersion Oil Kit recommended by 
the Agard lab but did not see a notable benefit. 



 

2.4) It might be useful to talk about the drawback of bidirectional scanning in some older 

systems. 

 

In section 2.4, we now state that bidirectional scanning should be used only if control 
experiments confirm that the scans from the two directions are in register. 

 

2.6) Why was a pinhole of 1.2 a.u. specifically chosen (rather than 1.4 or 1.6). Was the resolution 

judged by eye as suitable for imaging the golgi? Is 1.2 suitable for other structures? 

 

We find empirically that using a pinhole of 1.2 Airy units rather than the conventionally 
recommended 1.0 Airy unit enhances photon recovery without noticeably degrading the 
resolution. A plausible explanation is that there is a refractive index mismatch between the 
oil/glass and the yeast cells, so the optics are suboptimal and the 1.0 Airy unit setting does not 
provide the benefit that would be obtained with no refractive index mismatch. However, 
increasing the pinhole above 1.2 Airy units does degrade the resolution. 
 
An abbreviated version of this explanation has been added to section 2.6. 

 

2.13) Why is it necessary for the images to be 8-bit? Wouldn't a higher bit depth be preferable if 

you want to combine this analysis with fluorescence intensity measurement? 

 

8-bit images are more than sufficient for the number of photons that are captured with this 
protocol, and the processing pipeline is configured to accept 8-bit images. This point is now 
stated in section 2.13. 
 
Note that the images are converted to 16-bit during the average projection, because otherwise 
information would be lost. 

 

Results: 

Fig 3 - It would be useful to see an indication of the location of the segmented cisternae of the 

second rows indicated in the original image in this figure. 

 

The suggested change has been made. 
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Editing 4D Movies with ImageJ Plugins 

 
The goal is to edit a 4D movie to display only one or a few spots. An edited movie can be 
analyzed to quantify the fluorescence time courses. 
 
Typical Workflow 
This procedure assumes that you are starting with a deconvolved and bleach corrected 
movie in the form of a 4D TIFF hyperstack. The description is for a movie with three 
fluorescence channels plus a fourth channel for the cell images, but if there are fewer 
fluorescence channels, the procedure is essentially the same. 
 
The custom plugins for 4D movies should be placed in a folder within the ImageJ 
“plugins” folder. Detailed instructions for using these plugins are provided in later 
sections of this document. 
 
1. Run the “Make Montage Series” plugin, and choose the 4D TIFF hyperstack. The 

result will be a scaled montage with adjusted gray values for the cells. In addition, 
the blue channel color will be adjusted to make the signal easier to see. Save this 
montage series. 

 
2. Run the “Montage Series to Hyperstack” plugin. The result will be a 4D hyperstack 

that includes the adjustments described above. Save this hyperstack. 
 
3. Run the “Project Hyperstack” plugin. The result will be an average projected 

composite TIFF movie showing all of fluorescence signals. Save this original movie. 
 
4. View the original movie, and identify one or more structures that can potentially be 

followed cleanly in all three fluorescence channels. Note the positions and times at 
which those structures are present. 

 
5. Run the “Edit Montage Series” plugin. Choose the previously saved montage series, 

and create a copy for editing. 
 
6. Edit each fluorescence channel of this montage series so that it displays only the 

structure of interest in all three channels. Erase all of the extraneous fluorescence 
signals. Save this edited montage series. 

 
7. If additional structures of interest were identified, repeat steps #5 and #6, creating 

an additional edited montage series for each structure. 
 
8. Run the “Montage Series to Hyperstack” plugin for each edited montage series. Save 

these edited hyperstacks. 
 
9. To quantify the fluorescence signals from each isolated structure, run the “Analyze 

Edited Movie” plugin for the appropriate edited hyperstack. Save the results. 
 
10. If you wish to show more than one isolated structure in a combined edited movie, 

run the “Merge Two Hyperstacks” plugin and merge the first two edited hyperstacks. 

Instructions for Plugins Click here to access/download;Supplemental File (Figures,
Permissions, etc.);Editing and Processing 4D Movies.pdf

http://www.editorialmanager.com/jove/download.aspx?id=879173&guid=db155464-58c6-4ab6-82b9-0ce122f2cff9&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=879173&guid=db155464-58c6-4ab6-82b9-0ce122f2cff9&scheme=1
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The same plugin can be run again to merge in additional edited hyperstacks. Save 
the merged edited hyperstack, which can be projected to make the edited movie. 

 
11. If you wish to show the original movie above the edited movie, run the “Merge 

Hyperstacks” plugin again, but this time choose the option of placing the original 
hyperstack above the edited one. 

 
12. Once you have a fully processed hyperstack, run the “Project Hyperstack” plugin. 

Save the resulting final movie.  
 
13. If you wish to make changes in how the fluorescence signals were edited, go back and 

edit the appropriate montage series, then regenerate the final movie. 
 
14. As described below, use ImageJ to adjust the display parameters for the final movie 

if desired, and then generate an MP4 version of the final movie. 
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Plugin: Make Montage Series 
1. Run the plugin, and choose a 4D 8-bit TIFF hyperstack from a confocal. This data set 

should already be deconvolved, bleach corrected, and cropped if desired. 
 
2. Choose a scale factor for magnifying the individual slice images. The default value is 

4.0, but you can choose another number as long as the montage will fit on the screen. 
 
3. Choose the slices that will be used to create the montage. You can omit slices that 

have no fluorescence data. (Alternatively, such slices can be removed ahead of time 
by editing the hyperstack in ImageJ.) 

 
4. Allow the montage series to be created. The plugin cannot be aborted during scaling, 

but can be aborted using Esc during assembly of the montage series. 
 
5. Save the montage series, which will serve as the “original” montage series during the 

editing phase. 
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Plugin: Edit Montage Series 
1. Run the plugin, and open the original montage series. 
 
2. The first time you work with a given montage series, choose the option “Create New 

Montage” to duplicate the original montage series. 
 
 If you have already begun editing the montage series, use “Open Existing Montage”, 

and choose the edited montage series. 
 
 In either case, the edited version of the montage series will be displayed on top of the 

original version. 
 
3. Use the keyboard commands listed below to work with the original and edited 

montage series. You can also use the sliders at the bottom of the window. It is 
recommended to use these controls whenever possible rather than the standard 
ImageJ menu commands and image adjustment dialogs. 

 
a) Use Tab to switch between the original and edited montage series windows. 

These two windows should stay synchronized with respect to channel, time point, 
and display parameters. 

 
b) Use the Left Arrow and Right Arrow keys to move between time points. You can 

also drag the lower slider. 
 
c) Use Opt together with the Left Arrow and Right Arrow keys to switch between 

channels. You can also drag the upper slider. 
 
d) Use the Up Arrow and Down Arrow keys to increase or decrease the display 

brightness of the currently selected channel. 
 
 Use Opt together with the Up Arrow and Down Arrow keys to jump to either the 

default brightness, or the maximum or minimum brightness, depending on the 
current brightness setting of the currently selected channel. 

 
e) Use the R, G, and B keys (uppercase or lowercase) to toggle visibility of the red, 

green, and blue channels, respectively. Use the Y key to toggle visibility of the 
gray channel showing the cells. 

 
f) With the edited montage series visible, use the Z key to replace the edited 

contents of the currently displayed channel and time point with the original 
contents. 

 
 Note that Z is not a generic Undo key. This replacement function is irreversible. 
 
g) Use the A key to select the entire image. 
 
h) Use the E key to erase all of the fluorescence in the selected channel going 

forward or back in time. You will be prompted to choose the direction. 
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i) To delete everything except the desired spot, first select the spot in each of the 
relevant slices by drawing regions of interest (ROIs). A fast method for drawing 
ROIs is described below in (j). 

 
 You can use Shift to add pixels to an existing ROI, or Opt to trim pixels from an 

existing ROI. 
 
 When you are satisfied with the ROI, press the Delete key. For the currently 

selected channel, the nonselected pixels outside the ROI will be deleted. 
 
 If you make a mistake, reverse the procedure by pressing Z. 
 
 If you want to delete the selected pixels inside the ROI, use Opt together with the 

Delete key. If nothing is selected, the entire image will be deleted. 
 
j) To automatically trace a spot in all of the relevant slices, do the following. First, 

select the spot by drawing a crude ROI. Make sure the appropriate channel is 
selected. Then press Return. The spot will be outlined in the original slice and in 
the adjacent slices. 

 
 If you change the brightness using the Up Arrow and Down Arrow keys, and then 

repeat the automatic tracing, the borders will expand or contract accordingly. 
 
 If the automatic tracing captures too much or too little, you can add to the 

selection using the Shift key or remove part of the selection using the Opt key. 
 
4. Periodically save the edited montage series. The S key will work for this purpose. You 

can return to the edited file later if you wish to make additional edits. 
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Plugin: Montage Series to Hyperstack 
1. Open an edited montage series. 
 
2. Run the plugin. Choose the desired time points to generate an edited hyperstack. 
 
3. This edited hyperstack can be merged with other hyperstacks as described below, or 

it can be projected to make a 4D movie. In addition, it can be quantified using the 
Analyze Edited Movie plugin described below. 
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Plugin: Analyze Edited Movie 
1. Open a hyperstack generated from an edited montage series. 
 
2. Run the plugin. You will need to enter the time interval between Z-stacks. 
 
3. The results will be displayed in a window.  
 
 “Red”, “Green”, and “Blue” are the total signals from the Z-stacks at each of the 

indicated time points. 
 
“Red Integrated”, “Green Integrated”, and “Blue Integrated” are the time-dependent 
numerical integrals of the signals. 
 

4. If you click on this window and then save, the result will be a file that can be opened 
by Excel. You can then plot the data to show the primary or integrated fluorescence 
signals over time. 
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Plugin: Merge Two Hyperstacks 
1. Run this plugin, and choose two hyperstacks generated by the “Montage Series to 

Hyperstack” plugin.  
 
2. If you want to merge two edited hyperstacks to show two isolated structures in the 

same movie, choose the default “Merge fluorescence signals” option.  
 

If desired, the resulting hyperstack can be used as the input for another iteration to 
merge in data for a third isolated structure, and so on. 
 

3. If you want to show the original movie above the edited movie, choose the “Place 
first above second” option.  

 
First choose the hyperstack corresponding to the original movie. Then choose the 
hyperstack corresponding to the edited movie, which may show two or more isolated 
structures as described in step #2. 
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Plugin: Project Hyperstack 
1. Open a hyperstack that was either generated directly by the “Montage Series to 

Hyperstack” plugin, or further processed using the “Merge Two Hyperstacks” plugin. 
 
 If desired, you can examine this hyperstack to see if there are slices at the top or 

bottom that contain either no fluorescence throughout the time course, or 
extraneous background fluorescence. 

 
2. Run the “Project Hyperstack” plugin. When prompted, choose whether to project all 

of the slices, or to remove undesired slices from the top or bottom of the stack. 
 
 Make sure that “Average intensity” is chosen for the projection. You can choose to 

project all of the time points, or just a subset if desired. 
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Adjusting and Converting the Final Movie 
1. The result of the “Project Hyperstack” plugin should be a movie that is easy to view 

and appropriately scaled. However, you can adjust the output for each channel as 
follows. 

 
a) Choose Image > Adjust > Brightness/Contrast. In the projected movie, use the 

“c” slider to choose the channel (red, green, blue, or gray) that will be adjusted. 
 
b) Adjust the “Maximum” slider as desired to set the output of a given fluorescence 

channel.  
 

Alternatively, click “Auto” and then drag the “Minimum” slider back to “0”. 
 
Alternatively, click “Set” and specify the values manually. This approach is 
particularly useful if you wish to have identical display values for two movies, 
e.g., an original and an edited movie. 
 

c) Another way to adjust a channel is by choosing Process > Enhance Contrast. A 
value of 0.1% saturated pixels will give the same result as the “Project 
Hyperstack” plugin. You can vary this number as desired. 

 
2. To add a time stamp, choose Image > Stacks > Label. Use the format 00:00, with the 

appropriate time interval in seconds.  
 

To place the label in the lower left corner, set the Y location to be 1 less than the Y 
value of the lowest row of pixels.  
 
To place the label in the lower right corner, also set the X location to be 55 less than 
the X value of the rightmost column of pixels. 

 
3. To make a movie for publication, choose File > Save As > AVI. For the compression, 

choose PNG. A frame rate of 10 fps is typically suitable. 
 
 Convert the AVI file to MP4 format at https://video.online-convert.com/convert-to-

mp4. 



  

"Analyze Edited Movie" Plugin

Click here to access/download
Supplemental Coding Files
Analyze_Edited_Movie.java

http://www.editorialmanager.com/jove/download.aspx?id=879174&guid=4e065e90-b0b7-4895-929f-b9666b844363&scheme=1


  

"Edit Montage Series" Plugin

Click here to access/download
Supplemental Coding Files
Edit_Montage_Series.java

http://www.editorialmanager.com/jove/download.aspx?id=879175&guid=3f9bedcf-8ead-4b42-a068-0e00d609126d&scheme=1


  

"Make Montage Series" Plugin

Click here to access/download
Supplemental Coding Files
Make_Montage_Series.java

http://www.editorialmanager.com/jove/download.aspx?id=879176&guid=eca5dd9d-e9e8-414f-8e20-60b1019022d7&scheme=1


  

"Merge Two Hyperstacks" Plugin

Click here to access/download
Supplemental Coding Files

Merge_Two_Hyperstacks.java

http://www.editorialmanager.com/jove/download.aspx?id=879177&guid=3c2b282d-ed1f-4e24-9ff6-a725b223f832&scheme=1


  

"Montage Series to Hyperstack" Plugin

Click here to access/download
Supplemental Coding Files

Montage_Series_to_Hyperstack.java

http://www.editorialmanager.com/jove/download.aspx?id=879178&guid=cb76a6a7-11cb-4697-a382-b2052d5fa167&scheme=1


  

"Project Hyperstack" Plugin

Click here to access/download
Supplemental Coding Files

Project_Hyperstack.java

http://www.editorialmanager.com/jove/download.aspx?id=879179&guid=780d3178-bc53-40d9-8648-49efdb4d2b65&scheme=1

